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1. INTRODUCTION TO THE AMAZON DIGITAL TEXT PLATFORM™

Amazon’s Digital Text Platform™, or DTP, is a conversion tool used to create content for the

Kindle™ ebook reader device, and put that content up for sale in the Amazon Kindle™ Store.

You cannot use the DTP to create Kindle™ editions of your work for your own personal use, the

content creation process automatically generates an accompanying Amazon product page.

2. WHY PUBLISH WITH DTP?

Assuming you’ve already made the decision to self-publish, there are three very good reasons

to go with Amazon DTP: it’s easy, it’s free, and it gets your work onto the virtual shelves at

Amazon in a matter of days. While it’s true that only Kindle™ owners will be able to buy your

DTP book, and they are a relatively small group as compared to the book-buying general public,

these are the very circumstances that offer some distinct advantages over other forms of self-

publishing.

First, because Kindle™ owners are a small and specific population, it’s easy to target your

promotional efforts by seeking out their blogs and discussion groups. Second, because the

Kindle™ book store has a much more limited inventory than the ‘regular’ Amazon book store,

you don’t have to sell many copies of your DTP book to quickly rise into the Kindle™ store

bestseller ranks. Finally, because Amazon book listings combine reviews and sales figures from

all available editions of a given book, you can use your DTP edition to accumulate sales and

reviews to support a POD release in the ‘regular’ book store: the day your POD book goes on

sale, it can already have sales and positive reviews associated with it from the Kindle™ book

store.
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3. SOME QUESTIONS AND ANSWERS ABOUT THE DTP

3.1. WHO CAN USE THE DTP?

As of this writing, anyone with an Amazon account can use the DTP to create
and sell Kindle™ editions of anything from short fiction to doorstop-sized tomes.

3.2. IN GENERAL, HOW DOES IT WORK?

You begin by entering details about your book, such as title, category, author
name(s), keywords, description, etc. Next, you upload your manuscript in HTML
format (don’t panic, Word™ can convert a .doc to .html for you automatically)
and optionally upload cover art as a .jpg or .gif image. When the upload is
complete, you can preview what your manuscript will look like on the Kindle™
from your web browser screen. If all looks correct, the final step is to set your
price, save your changes, and then ‘Publish’ with one final button click.

3.3. WHAT DOES IT COST?

There is no cost to set your book up for sale as a Kindle™ edition via the DTP.

3.4. HOW LONG DOES IT TAKE?

It takes anywhere from 20-45 minutes to fill in the necessary online forms,
upload and preview your DTP edition. From the time you click the ‘Publish’
button, signifying your approval of your book, its details and the associated cover
art, it takes approximately 3 business days for your book to show up in the
Kindle™ book store.

3.5. WHAT RIGHTS DO I GIVE UP WITH DTP?

First, the usual caveat: legal advice is outside the scope of this article, and full
disclosure on the matter can be found in the DTP Terms and Conditions, which
can be accessed here. If the document should be moved at some point in the
future, rendering the above link broken, just go to http://dtp.amazon.com, click
the Support link, and do a search on “Terms & Conditions” in the support area.

Having said that, in agreeing to the Terms & Conditions you’re granting Amazon
sole right to sell, distribute and promote the Kindle™ edition of your work, as
created by the DTP, in whatever manner they see fit. You’re agreeing to let
them share free digital excerpts and images of your work taken from the
Kindle™ edition (i.e., ‘Search Inside the Book,’ ‘Read A Free Excerpt,’ etc.), as
well as to discount, bundle or cross-sell your Kindle™ edition work as they wish.
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However, your percentage of the profit from each sale is always based on the list
price you set, regardless of the price at which Amazon ultimately sells the book--
-more on that later. You’re also granting them the right to release the work to
customers who buy it, store the work on their servers or the servers of their
designee(s), and store the work on behalf of purchasers in each purchaser’s
‘digital locker’.

You are not giving up any other rights to publish any other editions of your work,
not even other ebook editions. Given that the Kindle™ file format is proprietary
and specific to the Amazon DTP, it’s not as if standalone DTP/Kindle™ rights
could ever be sold to another entity anyway. Still, it’s worth mentioning that this
is still a form of self-publishing, so any agent or publisher with a slant against
self-publishing will probably be turned off by publication of your Kindle™ book
regardless of your largely intact rights.

There are more details in the Terms & Conditions, and I urge you to read it in its
entirety, and even consult with an attorney about it if you have any doubts,
before you decide whether or not to use the DTP.

3.6. DOES MY BOOK NEED TO HAVE A PRE-ASSIGNED ISBN?

No, and you don’t have to purchase one for your DTP book, either. Note that
generally, where ISBNs are used each different edition of a book (i.e.,
audiobook, hardcover, trade paperback, ebook) is assigned a unique ISBN. This
means that you cannot assign the ISBN used for some other edition of your book
to the DTP edition. However, since the DTP does not require an ISBN you also
don’t have to buy a new one just for the DTP edition of your book. An internal
Amazon Store Identification Number (ASIN) will automatically be assigned to
your DTP book when it’s released to the store.

3.7. WHAT IS MY AUTHOR ROYALTY ON MY DTP BOOK?

As of this writing, your author royalty is 35% of the list price you set when you
enter the details for your DTP book. For example, if you price your book at 4.99,
your royalty on each copy sold is $1.75. Even if Amazon discounts your book
and sells it for say, 20% off the list price, you still get $1.75 for each copy sold.

3.8. HOW HARD IS IT, REALLY?

As you might expect, the more and better your computer skills, the easier it is to
do a really professional-looking job of things. Even with only intermediate skills
in MS Word™ and beginner skills in your chosen graphics or photo editing
program (to create cover art), so long as your manuscript doesn’t have
illustrations or other graphics in it, you will be able to manage without much
difficulty. Directions for converting manuscripts that have illustrations or
graphics are provided herein, but as of this writing the DTP isn’t really set up to
handle graphics all that well. If your book is heavily dependent on illustrations, I
do not recommend converting it via DTP.
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3.9. CAN YOU ANSWER MY TEN MILLION OTHER QUESTIONS?

No, but the folks at Amazon DTP can. Go to http://dtp.amazon.com, click the
‘Help’ link, and avail yourself of the Getting Started Guide, Formatting Guide,
FAQ and Additional Information links. Also feel free to peruse the Ask The
Community user forums, as many specific questions, concerns, tricks and tips are
also discussed there.

4. GETTING READY FOR THE DTP

First things first: as mentioned above, it’s a very good idea to go to http://dtp.amazon.com,

click the ‘Help’ link, and avail yourself of the Getting Started Guide, Formatting Guide, FAQ and

Additional Information links. The links will take you to help pages where you can download pdf

guides, tutorials, and a quick start guide. Grab a copy of everything available, and read all of it.

Then come back to this document for a simpler set of instructions that also cover some tips,

tricks and gotchas not included in Amazon’s materials.

You will have to provide a tax ID number (i.e., social security number) and bank information in

order for Amazon to pay you your author royalties. Don’t get all paranoid about this, because

any author must provide a tax ID number to his or her publisher, and the bank information is

only needed so that Amazon can electronically transfer your royalties directly to your bank

account instead of cutting and mailing a check.

5. DON’T USE ANYTHING LESS THAN A FINAL, ‘LOCKED’ DRAFT

Remember, once you click that ‘Publish’ button your work is on its way to the Kindle™ store

shelves for the whole world to see. Do not publish anything via DTP that you would not feel

comfortable seeing on the shelf at your local brick-and-mortar bookstore with your name on the

cover. This is not the time or place for anything less than a final, completely polished draft that

you’ve ‘locked’ against more revisions.

Your manuscript should be a ‘proof,’ containing everything you would expect to include in a file

being sent to press for creation of paper books: author dedication page, ‘About the Author’

page at the back, ‘Other Titles From [your name]’ page, prologue and/or epilogue if applicable,

etc. About the only page you’d typically see in a printed book that’s not necessary here is the

page with publication details.
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6. PREPARING YOUR MANUSCRIPT FOR DTP

This article assumes you have a copy of your manuscript in MS Word™ 2003 or higher. While it

is possible to upload any manuscript formatted as HTML to the DTP, the method described here

is specific to using MS Word™ 2003 or higher.

6.1. ‘SAVE AS’ TO CREATE A COPY FOR DTP

Your manuscript is probably formatted according to publishing conventions: double-

spaced, wide margins, etc. You will need to change many of these settings for your

DTP edition, so create a copy of the manuscript just for DTP formatting.

6.2. MODIFY YOUR FORMATTING TO MAKE IT HTML-COMPLIANT

I’m not going to lie to you…this part of the process is not fun. But at the end you will

be saving your manuscript as an HTML file in which most of your Word™ formatting

options will be lost, along with any embedded graphics and special characters such as

Webding symbols. Therefore, to save yourself from unwelcome formatting surprises

after you upload to DTP, you want your text to be as minimally-formatted as possible

before saving as HTML. When you’re done, the HTML version of your manuscript should

be virtually identical to the Word™ version you used to create it.

Note that if your manuscript includes illustrations, diagrams or other graphics, you must

store those pictures as individual files outside of your document, in .jpg, .gif, .tiff or

ideally, .png format, and replace them with HTML pointers in the document. If you can’t

extract (or copy) the pictures to be saved separately, if you don’t know how to reformat

the graphics’ size and dimensions, or if the graphics can’t be saved in .gif, .jpg or .png

format, you won’t be able to include those graphics in your Kindle™ book.

Directions are provided below for how to set the HTML pointers to your graphics, but if

you’re not comfortable editing an HTML file of your manuscript you will struggle with

graphics. In such a case, you will have to choose between removing the graphics, or

publishing to a format other than Kindle™ (i.e., trade paperback).
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Moderate to advanced HTML skills are required if you need to tightly control the location

of each graphic/picture on the page, or the way your text ‘wraps’ around the graphic in

a page; such HTML instruction is beyond the scope of this Guide, so the instructions

here assume you do not need or want that level of formatting control. Finally, you must

be able to save the manuscript and graphics files in a single, .zip file for upload to the

DTP system.

The DTP guides all talk about making changes to your HTML file to correct formatting

problems, but it’s much easier to make all the changes you possibly can in Word™, a

program you know well, than to go trudging through lines of HTML code trying to figure

out how to make it look the way you want. If you follow this checklist, you should have

a pretty clean file when you’re ready to save as HTML and should not have to go

through multiple iterations of uploading to DTP, previewing, making changes and

uploading again to resolve formatting issues. As you go through these steps, save

frequently (still in Word™ format---you won’t ‘Save As’ HTML until all changes and

corrections have been made).

1) Delete the extraneous, add the necessary

a) Delete any blank pages that were inserted into the original manuscript for
purposes of ‘facing pages’ formatting. Delete your headers and footers,
as they’ll be lost in the conversion process anyway. Don’t worry about
losing your page numbers, as the Kindle™ automatically regenerates
digital page numbers each time it loads a file. If you haven’t already
done so, insert a Title Page at the front of your manuscript with your
book’s title, your name and any copyright information (if applicable).

2) If you’ve used Styles in your manuscript, clean them up

a) In the course of writing and revising, you may have inadvertently
formatted various sections of your text with differently-named Styles.
This can happen when you need to switch from one Style to another, say
from Chapter Heading to Body Text, and instead of selecting the correct,
pre-existing Style from the Styles list, you manually apply format changes
to your text blocks on the fly. Make sure that all like-formatted sections
of text have the same Style applied to them.

3) Modify your margins and line spacing

a) Change your margins to no more than 1” all around, and change your
body text line spacing from double-spaced to 1.5 line spacing throughout.
Double-spaced text takes up an annoying amount of screen real estate on
an ebook reader, and all that extra white space doesn’t actually improve
its readability.
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4) Ensure your text is HTML-friendly

a) HTML can render body text, indented text blocks, numbered or bulleted
lists, and simple tables, as well as italics, boldface and enlarged text. It
can render only a handful of fonts, with Arial, Tahoma and Verdana being
the most commonly-used and easy to read. Font size should be set to
10-pt or 11-pt, depending on your chosen font, for easy readability. You
can use a larger font size, but since the Kindle™ has an enlarge text
function it’s not really necessary. Make any needed changes to your
manuscript so that its contents will meet these fairly limited parameters.

5) Omit extraneous carriage returns, page breaks and section breaks

a) Section breaks will not be recognized in the HTML conversion, but page
breaks will. It’s appropriate to use page breaks at the end of each
chapter, but delete any that were used to try and fudge line spacing,
widow or orphan control in printed manuscript copies. Also delete
extraneous carriage returns which may have been used to offset
differently-formatted sections of text, but are no longer necessary now
that your formatting is being greatly simplified. HTML will interpret each
carriage return as the start of a new paragraph, and may insert unwanted
blank lines between those paragraphs.

6) Use Search and Replace to locate and delete or replace any special
characters

a) For example, if you’ve used a bullet icon such as a star or snowflake as a
graphic element to create dividers between sections of text, you will need
to delete those bullets or replace them with a regular character, such as
an asterisk or dash. HTML has its own set of supported special
characters, but unless you’re well-versed in HTML it’s safer and easier to
just fall back on standard keyboard characters.

b) Subscripts and superscripts are also not likely to translate properly; locate
all such instances and reformat accordingly

7) Save any pictures as external, individual files

a) Create a folder to hold your manuscript and all your graphics files

b) Extract or copy each graphic and save each as an individual file in the
same folder as your manuscript—do not save them in a sub-folder.
Leave some type of easy-to-find placeholder note or text to indicate
where each picture should appear in the manuscript.

8) Edit each graphic to conform to Kindle™ requirements

a) Edit each graphic file so that its dimensions are no larger than 450 x 550
pixels, its file size is no larger than 64kb, and its aspect ratio is 9:11. If
you have no idea what any of this means, you lack the skills and
knowledge needed to include graphics in your Kindle™ book; you can
omit them from your manuscript, brush up your graphics editing skills, or
get a more knowledgeable person to edit the images for you.
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b) Save each graphic in .gif, .jpg, .tiff, or .png format. The preferred format
is .png, as that format converts most easily.

9) Do not replace the images/flags in your manuscript with HTML pointers yet;
this step will occur after you’ve finished with all other formatting changes and
have saved the file as HTML.

6.3. INSERT A HYPERLINKED TABLE OF CONTENTS

Ebook users have come to expect a hyperlinked Table of Contents, and this is again

where they tend to cut the non-professionals from the herd in judging which books are,

or are not, worth their time and money. Fortunately, it’s very easy to create a

hyperlinked Table of Contents in Word™, and when you ‘Save As’ HTML the hyperlinks

will be preserved.

1) Ensure each chapter of your manuscript has a chapter number or title on its
first page, and that the number or title is formatted as "Heading 1" style
(select the text, then click Format > Styles and Formatting, and select the
"Heading 1" style from the list provided to make the chapter number/title a
Heading). If you don't like the way "Heading 1" looks, you can right-click on
"Heading 1" in the Styles list and select "Modify" to use all the usual text
formatting tools (i.e., font, size, bold, paragraph spacing, indent type, etc.
etc.), but remember to stick to formatting that will be HTML-friendly.

2) Go to the page where you want the Table of Contents. Click in the desired
position on the page.

3) Click Insert > Reference > Index and Tables > Table of Contents tab. Click
the boxes for "Show Page Numbers," "Right-Align Page Numbers," and "Use
Hyperlinks Instead of Page Numbers". Also set the "Show Levels" drop-down
to "1". Click “Apply” to save these changes.

6.4. ‘SAVE AS’ HTML

Do one last save of the manuscript in Word™ format before proceeding. Remember, if

the uploaded file needs further corrections or changes, you will want to modify this

Word™ file, not the HTML version.

Now ‘Save As’ and select “Web Page (*.htm, *.html)” as the file type. You may want to

give this version a distinct name as well, but it’s not really necessary since the file

extension will be changed from .doc to .htm so it won’t be hard to tell this file apart

from the Word™ file later.
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After you click ‘Save’ you’ll be looking at the HTML version of the file. If you’ve properly

corrected and simplified all your formatting, other than any graphics you’ve replaced

with placeholders, there shouldn’t be any significant differences between this HTML

version and the Word™ file.

6.5. INSERT HTML POINTERS TO GRAPHICS, IF APPLICABLE

Close the HTML file and close Word™. Open a simple text editor program, such as

Notepad (located in the Accessories folder of Windows™). Make sure the Word Wrap or

Text Wrap option is turned off. In Notepad, you can do this by making sure the Word

Wrap option in the Format menu is unchecked/de-selected. Open your HTML file in the

text editor. It will look seriously messed up to you, not at all like your Word™ file, but

don’t worry: that’s how HTML is supposed to look when viewed in a text editor.

Use the Edit > Find function to locate each graphics placeholder in your file and replace

it with the text shown below to create an HTML pointer to the appropriate, reformatted,

separately-saved graphics file:

<IMG SRC=”[myimagefilename].[myimagefileformat]”>

For example, if you saved a graphic with the name “Chap2Fig2” in .png format, your

HTML pointer would look like this:

<IMG SRC=”Chap2Fig2.png”>

WARNING: Do not alter a single character of any text in the HTML file other than your

graphics placeholders. A single extraneous character, or character out of place, in an

HTML file can ruin your formatting, or even make the HTML fail to display at all. Be

careful, but remember that even in the event of a total disaster, you can just delete the

damaged HTML file, re-open the Word™ file, and re-do the “Save As HTML” step to

create a new HTML file.

When you’re done, save the file in the text editor program. Make sure that when you

save, the file extension/type shown is “.html”, not “.txt”.
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6.6. VERIFY HTML GRAPHICS POINTERS, IF APPLICABLE

Inserting an HTML pointer will not make the associated graphic appear in the document

as you’re viewing it in the text editor. You must view the HTML in a browser to verify

your graphics pointers are working properly.

Locate your saved .html file on your computer and double-click it. Since the file type is

.html, your computer will recognize it as a web page and open it in your usual web

browser program (i.e., Internet Explorer™, Mozilla Firefox™, etc.). You will be looking

at an approximation of how your content will look on the Kindle™, but not a very good

one. This is because the Kindle™ screen displays everything in a 9:11 aspect ratio—

roughly the same shape and overall dimensions as a page from a large-format trade

paperback book, whereas most computer screens are wider than they are tall. Pages of

your book will look a lot wider on your computer screen than they will on the Kindle™

screen. You’ll be able to view a much more accurate approximation of how your book

will look on the Kindle™ later, after uploading your finished content to the DTP. This

first preview is only being done to ensure your graphics are all displaying in the correct

locations, which indicates your graphics pointers are working.

If any of your graphics are missing, go back to step 6.5 above to double-check the

pointers you inserted. HTML is finicky, so just one bracket, quotation mark or period out

of place will mess up a pointer. If your pointers all seem to be correct, verify that every

graphics file is located in the same folder as your manuscript file, not in a sub-folder or

any other location.

6.7. SAVE FILES IN A .ZIP ARCHIVE, IF APPLICABLE

Manuscripts with graphics must be uploaded to the DTP in the form of a .zip archive file

which contains the manuscript file and all associated graphics files. In Windows™ XP™

or higher, you can simply right-click on the folder and select “Send To > Compressed

(zipped) folder” to create the .zip file. On Apple™ computers running OS X or later, Ctrl-

click the folder and select “Create Archive”. If your computer doesn’t offer this option,

you will need to run the appropriate zipping program to complete this task. If you don’t
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already have such a program, do an internet search on “WinZip” or “zip file” to locate a

free download of a zipping program online.

7. PREPARE YOUR COVER ART

Kindle™ store customers judge the lack of cover art, or the presence of stock-photo cover art,

to be a hallmark of the non-professional. You definitely want some nice cover art for your DTP

book, and you want it to match the cover art of all other editions of your book for consistency’s

sake. Even if you don’t have any other editions available yet, don’t skimp on the time or effort

here because whatever you create for DTP will have to serve for possible future POD books.

You don’t need a top-of-the-line graphics program to create this cover art, however. Anything

from a greeting-card program to MS Paint can get the job done, but of course a dedicated

graphics or photo-editing program will generally offer more and better options. You can use

any public-domain or purchased clip art in your cover image, but you may not use graphics

copied off the internet. Also be aware that, apart from photos in purchased clip art and stock

photo collections, if you intend to use a photo in which anyone’s face is recognizable, you must

have a written and signed release from every living person who is recognizable in the photo. If

any of those people are celebrities, even if the person is dead you may have to obtain a written

and signed release from surviving family members. It’s best to avoid these hassles entirely by

sticking to purchased clip art and stock photos.

There is a separate IndieAuthor guide to creating cover art, but for purposes of this article all

you need to know is that your cover art must meet Amazon™ product image standards: TIFF

(.tif/.tiff) or JPEG (.jpeg/.jpg) format, with image pixel dimensions of at least 1000 pixels on the

longest side. Color mode must be “sRGB” (this is the default for most graphics programs), not

“CMYK”, and of course you’re going for a typical, rectangular shape and proportion such as

you’re used to seeing on any book. Refer to your graphics program documentation or help files

for more information on how to create or edit your cover art to meet these requirements.

8. CRAFT YOUR BOOK DESCRIPTION

You are only given 200 words for your book description, which will appear on your Amazon™

product page when the book is released. Look at a few such descriptions for bestsellers in the

Kindle™ store to get some idea of how to approach this. You’re going for a synopsis that says
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enough about the story to lure a reader in, but doesn’t give away too much. Create a separate

Word™ or .txt document just for the description, so you can spend some quality time working

and reworking it until it’s exactly what you want.

9. READY, SET, DTP!

The details of how to fill out the required fields for DTP processing are already covered in the

Amazon™ DTP guides I’ve mentioned previously, and I will not rehash them here. Just note

that only fields marked with a red asterisk are required, so don’t feel obligated to make up a

Publisher Name, or a Series Name if it’s really not applicable to your book. For my DTP books, I

left the ISBN, Publisher Name, Series Title and Series Volume all blank. I entered “1” for

Edition Number, and I entered as many search keywords (i.e., comic fiction, mystery, Midwest,

womens fiction, etc.) as I could possibly think of that would fit in the space provided. The

keywords will help customers find your book when they search the store, so don’t be afraid to

really go nuts with them. More keywords = more people finding your book. Also note that

when it comes to filling in your Book Description field, all you have to do is copy the description

you created previously and paste it into the field.

Follow the instructions to “Enter Product Details” and “Upload & Review Book” as outlined in the

Amazon™ DTP guides, and meet me back here after you’ve uploaded your cover image and

your HTML file. Remember that if your manuscript has graphics, you will be uploading a .zip

file, not just the HTML version of your manuscript file (see section 6.7).

10. LOOKING AT YOUR DTP PREVIEW

When the file is finished uploading, page through your DTP preview. Don’t just check the first

few pages, jump around throughout the file by using the “Go To Page” box at the top of the

preview screen. Look at the back pages, to be sure your ‘About the Author’ and other back-

material stuff came through okay. Do some spot-checking of the pages where new chapters

begin.

As of this writing, there is a known bug with the DTP that often causes graphics to display

smaller than they really are, or oriented incorrectly (i.e., in landscape instead of portrait) when

you view your file in preview mode. Unfortunately, there’s nothing you can do about this.
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According to the DTP Administrator on the DTP Help boards, if your graphics are displayed at all

you should just trust that they will display correctly when viewed on a Kindle™ screen.

Note that it will appear as if your text goes right to the edge of the screen on the right-hand

side, but this is deceptive. In reality, the Kindle™ will provide a white-space margin there on its

screen. Also note that your hyperlinked Table of Contents will have had its page numbers

removed and may seem non-functional. Page numbers are removed because Kindle re-

paginates and re-numbers the pages of each file it loads, but the hyperlinks in the Table of

Contents are updated to reflect the newly-generated page numbers at the same time. The links

in this new Table of Contents will seem ‘broken’, but that’s only because hyperlink functionality

is not available in the preview screen. So long as your Table of Contents entries are blue and

underlined, signifying hyperlinks, you can rest assured they will work.

11. IF THERE ARE PROBLEMS…

DO NOT open the HTML version of your file to make edits or corrections, as the DTP guides

suggest. Instead:

1) Delete the HTML version of your file; don’t worry, you’ll be replacing it with a
new one.

2) Open the edited-for-DTP Word™ manuscript---the one you saved in step 6.4,
right before doing the ‘Save As’ HTML.

3) Make any desired changes, and save the file, still in Word™ format.

4) Do a ‘Save As’ in HTML format, following the same directions from step 6.4
as you did previously.

5) Repeat steps 10 and 11.

12. IF IT LOOKS GOOD, SET YOUR PRICE AND PUBLISH!

Back at your DTP dashboard, click on that lowermost tab: Enter Price. The checkbox next to

“Kindle store” should already be marked. If it isn’t, place a checkmark in it by clicking on it.

Bestsellers that are only available in hardcover in the ‘regular’ book store tend to be priced at

$9.99 in the Kindle™ store, and those available as trade paperbacks in the ‘regular’ bookstore

usually run between $6.99 - $8. I price my Kindle™-edition novels at $4.99 and $5.99, partly in

recognition of the fact that I’m not a bestselling author and partly because I personally feel



IndieAuthor Guide to Using Amazon’s DTP™ With MS Word™

Independent Author Series 15 © April L. Hamilton
V 2.0 Dated 4/24/08

ebooks should always cost less than their paper-pulp counterparts. You will have to use your

own best judgment in deciding where to set the price point for your books, but remember that

your author royalty will be 35% of the price you set here, regardless of the price at which

Amazon™ ultimately sells each copy (see section 3.7).

Click ‘Save Entries’ on the ‘Enter Price’ tab. Go back and check all the entries in the first two

tabs one last time, just to be absolutely sure it’s all accurate and the way you want it. When

you’re ready, take a deep breath and click “Publish”.

Log back into your DTP dashboard in about three days to see if your book is marked “Live” yet.

First it will go “Live”, but not all the details will show up on the product page and it will be listed

as “not yet available” while Amazon™ works to get your book’s details added to all their various

databases. By the end of 5 business days at most, your book should be live, complete and

available for sale in the Kindle™ store.

13. AFTER YOUR BOOK IS PUBLISHED

You can log back into your DTP dashboard anytime you want and click on the “My Reports” tab

to see how many copies of your book have sold, and what your cumulative author royalty total

is to date. You can also re-upload and re-publish revised versions of your files at any time, but

if you’ve done everything according to this guide, it should never be necessary.

Finally, send an email to everyone you know, with a link to your book’s product page

on Amazon™. By gum, you’re a published author now!


